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Disclaimers

Copyright/disclaimer for manuals

 Copyright 1995/2024 Zuken Limited all rights reserved.

Warning! DO NOT COPY

Copyright in the whole and every part of this manual belongs to Zuken Limited 
and may not be used, sold, transferred, copied or reproduced in whole or in part 
in any manner or in any media to any person, without the prior written consent of
Zuken Limited. If you use this manual you do so at your own risk and on the 
understanding that neither Zuken Limited nor its associated companies shall be 
liable for any loss or damage of any kind.

CADSTAR and P.R.Editor are a registered trademarks of Zuken Limited.

Microsoft is a registered trademark, and Windows and the Windows logo are 
trademarks of Microsoft Corporation.

All trademarks are hereby acknowledged.

2  Installation and Getting Started



Table of Contents

Installation Guide...........................................................................................5

The Installation Tasks........................................................................................5

Installing CADSTAR...........................................................................................5

Setup for Licensing Information..........................................................................6

Specifying The Destination Of The Installation..................................................7

Setting The Type Of Installation..........................................................................8

Installation Of The Files......................................................................................9

Exiting From The Installation............................................................................11

Result Of Installation.......................................................................................12

Repair, Modify or Remove CADSTAR.............................................................14

Installing the Software Key Driver..................................................................15

Setting Up The Type Of Installation..................................................................16

Software Protection ........................................................................................18

Overview............................................................................................................18

Software key......................................................................................................19

Obtaining the license.dat File.............................................................................19

Finding out the Serial Number of your Key......................................................19

Sending E-mail to your Distributor....................................................................19

    Installation Guide 3



4  Installation and Getting Started



Installation Guide

The Installation Tasks

 First, install the CADSTAR Software.  

 Then, if necessary, install the Software Key Driver. If you are a new user this is an 
essential procedure.  A Software Key Driver is not required for a Network Licensed 
system.

 Finally carry out the Authorisation Procedure. Not required for a Network Licensed 
system.

Installing CADSTAR

To install  CADSTAR.

1. Download and open the installation exe.

The following progress dialog is displayed:

It informs you that the Installation Wizard is being run up.  

Each prompt displayed during the process tells you what it is about to do and 
prompts you to either continue with a Next button, or to exit from the installation
with a Cancel button. 

The first installation dialog is:

This welcomes you to the installation process.

2. Click Next.
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The next dialog displays the License Agreement, which you should read 
carefully:

If you accept the terms of the License Agreement:

3. Click on I accept the terms of the License Agreement.

4. Click Next.

On the next dialog you enter your personal name and company name:

5. In the User Name box enter your own name (or the name of the 
machine if you prefer), and in the Organization box enter the name of
the organization you work for.

These two items of information will be displayed on the dialog obtained by the 
About CADSTAR option (on the Help menu). 

6. If given the option, choose whether to install CADSTAR for all users or
just for the current user.

Setup for Licensing Information

On the next dialog you choose the style of licensing: 
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7. Choose either Node Locked Only or Network Licensed and/or 
Node Locked. If you choose Network Licensed you must also enter 
the Name and Port. Then click Next.

• Node Locked - is for specifying that you are installing a ‘stand-alone’ system 
which can only be used with one particular software key.

• Network Licensed - is for specifying that you have installed ‘network 
licensing’ software on an external server (host) and wish to communicate 
with this server. (Network licensing is explained in the User’s Guide provided
for that software). This button displays a dialog which creates the link from 
your system to the terminal on which the network licensing software is 
installed.

• Name identifies the machine on which the network licensing software is 
installed. 

• Port is a number that is set up when the network licensing software is 
installed. 

You should be able to obtain name and port from the network licensing system.

Specifying The Destination Of The Installation

The next dialog enables you to specify which folder CADSTAR will be installed 
in. A default appropriate for your operating system is displayed:

If you wish to change the destination of either the application files or user files 
from the default:

8. Click on the appropriate Change button.

A new dialog is displayed ready for you to select the directory you require:
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In the example above, it is set up to install the software in the default directory. 
The DLLs that make up CADSTAR will be installed in a sub-directory, 
automatically generated, called Programs.

9. Browse the folder tree or type in a directory path into the Folder 
Name edit control and click OK.

The Choose Destination Folder dialog is displayed again. If you are happy with 
the directory in which CADSTAR is to be installed:

10.Click Next.

Setting The Type Of Installation

The next dialog asks you what type of installation you require:

11.Select either Complete or Custom and click Next.

• Complete - is for installing all the possible CADSTAR applications.

• Custom - is for installing selected parts of the CADSTAR suite.

If you have selected Custom you must choose which components to 
install.
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Select an item from the feature tree to see a description. Sub-items can only be 
installed if the root items are installed too. For instance you cannot install SI 
Verify without installing P.R.Editor XR. 

Note: The Design Editor includes editors for: Schematic Design, PCB Design, 
Schematic Symbol, PCB Component, Documentation Symbol and Library Editor.

Change – Enables you to change the Install to directory. This is the same dialog 
that is documented above.

Help – Brings up a description of the icons in the feature tree.

Space – Displays a dialog showing how much free space you have on each of 
your drives.

12.Choose which applications and features you wish to install.

 If you are uncertain whether the installation will fit on the current drive:

13.Click Space then, if required, click Change to amend the install path.

Alternatively remove applications and features to be installed until you have 
enough drive space.

14. Click Next when ready.

Installation Of The Files

The next dialog gives a summary of the parameters you have set up so far, and 
allows you to assign file types to the installed applications.

15.If you do not wish to associate file types to the new applications 
Deselect the Associate file types... option.

    Installation Guide 9



The CADSTAR Design Tooltip Plug-in allows the Windows Explorer tooltip to 
display the version and patch number for design files.

16.If you do not want this feature, deselect the Install CADSTAR Design 
Tooltip Plug-in option.

This feature is not available in 64 bit versions of Windows

17.If you do not want CADSTAR to automatically check for new versions 
of the software, deselect the Automatically check for software 
updates... option.

Check the summary. If you are happy for the installation to proceed:

18.Press the Install button.

The installation now commences. A dialog displays progress information:

The following dialog appears when the installation is complete:

19.Press Finish to complete the installation wizard.
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Exiting From The Installation

If you wish to exit from the installation before it is complete:

20.Click Cancel on the progress dialog.

The following dialog is then displayed:

21.Click Yes.
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Result Of Installation

A set of application icons is created inside the CADSTAR folder in the 
computer's Start menu. Depending on OS, this is obtained by pressing the Start 
button to display the Programs menu or the Apps category. It will display the 
icons appropriate to the software you have installed.

Design Editor

This icon runs up the CADSTAR software, which allows you access to 
the CADSTAR programs (i.e. Schematic Design, PCB Design, 
Schematic Symbol, PCB Component, and Documentation Symbol).

Library Editor

This icon runs up an editor, which enables you to create and edit parts 
libraries. It also enables you to edit the contents of the Symbol and 
Component libraries.

Migrate Tool

This application is relevant to existing users who are updating from 
earlier versions of CADSTAR. It enables you to transfer the settings from
your previous installation into the new version.

P.R.Editor XR

This icon runs up the P.R.Editor software for component placement and 
route editing. It accepts designs from CADSTAR in the RIF format 
within a controlled directory structure.

P.R.Editor XR
HS

This icon runs up the P.R.Editor software for High Speed route editing. It
accepts designs from CADSTAR in the RIF format within a controlled 
directory structure.

SI Verify

This option runs up SI Verify. With this tool you can:

 Easily check key high-speed parameters such as characteristic 
impedance in a spreadsheet.

 Simulate your physical design with high accuracy to minimise bad 
prototype builds.

 Verify proposed high-speed topologies before implementation to 
make your design correct by construction. 

Simulation
Library

Manager

This icon runs up the Simulation Library Manager for use with High 
Speed routing.

The Simulation library contain Models that simulate the behaviour of 
pins on parts, thus enabling the P.R.Editor XR HS to calculate Overshoot 
and display the correct pin symbols on the Tree View in the Constraint 
Manager.

Sweeper

Useful for users of SI Verify, P.R.Editor XR HS or Board Modeler Lite. It
is advisable to run Sweeper before uninstallation of these applications or 
if you encounter problems with Cross Probing  or when closing them. 
Sweeper scans your system and removes any processes that have not 
properly closed.
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Constraint
Browser

This icon runs up the Constraint Browser software.  This can be used to 
set constraints and net topologies for schematic designs.

Analysis Result
Viewer

This icon runs up Analysis Result Viewer, a multi-purpose multi-domain 
display tool for analysis results.

User Notes

This icon displays informative notes, hints and tips, and extra 
information not included in the on-line Help.

User Guide

This automatically runs up the Acrobat Reader software and displays the 
CADSTAR User's Guide. If your system does not include a copy of 
Acrobat Reader, you can download it from http://www.adobe.com
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Repair, Modify or Remove CADSTAR

If after installation you wish to add or remove CADSTAR components you can 
do so from the Control Panel->Programs and Features. This option is also 
useful for repairing your CADSTAR installation if it becomes corrupt or stops 
working.

1. Select CADSTAR and click Change.

2. Click Next on the initial welcome screen.

The following dialog is displayed:

3. Choose whether you wish to Modify, Repair or Remove CADSTAR 
and click Next.

Modify brings up the Custom dialog. For details see step 15 in Installing 
CADSTAR above.

Repair scans your installed CADSTAR files and repairs any that have become 
corrupt or are missing.

Remove completely removes the CADSTAR installation.

Another wizard page will appear.

4. To continue press the relevant button, Install or Remove.
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Installing the Software Key Driver

This procedure is for installing the driver which enables the protected 
applications (i.e. Design Editor, Library Editor, and Route Editor) to 
communicate with their respective Software keys. 

1. Open the sentinel driver exe.

If you are an existing user with an old version of the driver, the following dialog 
is displayed:

2. Click Upgrade to continue with the installation.

An introduction to the Installation Wizard is now displayed:

3. Click Next.

The next dialog displays the License Agreement, which you should read 
carefully. 
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If you accept the terms of the License Agreement:

4. Click I accept the terms in the license agreement and then Next.

Setting Up The Type Of Installation

The next dialog asks you what type of installation you require:

Complete - for installing the drivers for both Parallel Port keys and USB port 
keys.

Custom Install - for selecting whether you install the driver for a Parallel port 
key or a USB port key.

It is recommended that you choose a Complete installation:

5. Select Complete and then Click Next.

The next dialog informs you that the installation of the Driver is about to start:
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6. Click the Install button.

If you are running a Windows Firewall the following dialog is displayed:

7. Click No.

Installation progress is displayed on the following dialog:

When installation is complete, you are informed by the following dialog:
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To exit from the Installation Wizard:

8. Click the Finish button.

You may obtain the next dialog (it depends on your operating system):

If you wish to continue using the newly installed Driver:

9. Click Yes.

You are now ready to continue on to the next stage of the installation if 
appropriate.

Software Protection 
Overview

Zuken Limited reserves the copyright on the software and prohibits the 
duplication of the software for use on other PCs simultaneously.

For all users - except those in a Network Licensed system - the software is 
protected by:

 A Software Key (a physical item that is plugged into your computer).

 A license for that key (stored in a file called license.dat).

If the Software Key or the license.dat is not installed, CADSTAR outputs the 
following message when you attempt to open a design: 

When you Click OK to proceed, the system starts up the software, but in the 
Unlicensed mode where you are restricted to a small number of components and 
pins.
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Software key

The Software Key is provided with your software.

It must be plugged into a USB port on your computer before you can use fully 
functional CADSTAR software.

Obtaining the license.dat File

A license.dat file is obtained from your Distributor by E-mail (refer to the 
following procedure on how to do this).

Finding out the Serial Number of your Key

First you will need to know the number of your Software Key in order to obtain 
the file. To find this out:

1. Plug the Software Key into a USB port on your computer.

If you have two keys (e.g. one for PCB Design and one for P.R.Editor XR) you 
need to process each key separately.

2. Run up CADSTAR.

3. Select the About CADSTAR option on the File>Help menu.

On the dialog displayed:

4. Click the Software Key Details button.

The Serial Number and ID of the node in which it is plugged are displayed. For 
example:

The Serial Number and Node ID need to be quoted when obtaining your license 
file.

5. Make a note of these two numbers before closing the dialog.

Sending E-mail to your Distributor

If you have an Internet connection, you can automate this process using the 
CADSTAR website:

6. Drop the Help menu again and then select CADSTAR Online.

When the CADSTAR site is displayed:

7. In the banner at the top of the page select the option Services, 
Training & Support, then choose - Request Your CADSTAR 
license. 

A ‘form’ is displayed, ready for you to enter the details which enable you to 
obtain the appropriate license.dat file. 

8. Complete the form, entering information in every box that requires it, 
and click the Submit button.

If you do not have access to E-mail or the Internet, communicate your 
requirements to the Distributor by FAX or Telephone as normal.

When you receive the license.dat file back from your Distributor:

9. Copy it to the  ..\Programs directory (within the CADSTAR installation 
path).
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